Appendix C

What’'s New In
Chief Architect X8

Welcome to Chief Architect X8. This Chapter Contents
appendix has been written to help our . Before You Begin
upgrading customers make a smooth . New and Improved Features by Chapter

transition from earlier versions of Chief
Architect to Chief Architect X8.

Before You Begin

There are many new features in Chief Architect X8, and many existing features have changed.
These changes affect the way Chief Architect functions, so it is very important to be familiar
with them.

o “Getting Started Check List” on page 1320

*  “Files Created in Version X7 and Prior” on page 1323

* “Files Created in Version X6 and Prior” on page 1323

*  “For Files Created in Version X5 and Prior” on page 1324
e “For Files Created in Version X4 and Prior” on page 1324
*  “For Files Created in Version X3 and Prior” on page 1326
*  “For Files Created in Version X2 and Prior” on page 1326

& Be sure to read this section before opening any plans created in earlier versions
of Chief Architect.
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Chief Architect X8 can open the .plan, .layout, .PL1, and .LA1 files from prior versions.
Before opening any files created in earlier versions of Chief Architect, it is important to be
aware of changes made in the newest version and the effect they may have on your legacy plan
and layout files. For details, see “Files Created in Version X7 and Prior” on page 1323, “For
Files Created in Version X2 and Prior” on page 1326.

Please note that files saved in the latest program version cannot be read by older versions of the
software. When a legacy file is saved in the version X8, an unaltered copy of the original file is
created which can still be opened in the original version. See “Legacy Archive Files” on page
60.

As in all software, every new program version introduces changes to its functionality as well as
to the user interface. If you choose to bring a project forward, be sure to take a few moments to
look it over in the new version and confirm that the new functionality does not require you to
make any modifications. Particularly if you have an approaching deadline, you may find it best
to finish the current project in the version of the software in which you began it.

Getting Started Check List

The following checklist suggests steps you should take before migrating your files to Chief
Architect X8. More information about each of these steps can be found after the checklist.

Check for and Install Program Updates

Migrate Legacy Library Files

Migrate Custom Graphics Files

Review the New Features List

Review Your Preferences Settings

Create new custom Template Plan and Layout files
Set up Custom Toolbar Configurations

Backup Entire Plan

Check chiefarchitect.com for more information

1. Check for and Install Program Updates

Program updates contain improvements to the original release version and we recommend
using the most current version available. By default, Chief Architect checks for program
updates every day when you launch the program. For information about changing this, see
“General Panel” on page 98. Please note that program updates are available for download,
which means that you need internet access to acquire them.

You can check for updates at any time:
* Select Help> Download Program Updates from the menu.

» Visit the Program Updates page on the Chief Architect Web site at chiefarchitect.com.
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2. Migrate Legacy Library Files

Library content from previous program versions cannot be installed or copied into the Chief
Architect X8 library. If you upgraded from version X1 or later and have custom library content
on your computer from that program version, the program installer will locate it and ask if you
want to migrate it into the Chief Architect X8 library. See “Migrating Library Catalogs” on
page 15.

You can import library files from versions X1 through X5 at any time by selecting Library>
Import Library (.calib, .calibz) from the program menu. In addition, library files from
versions 10 and prior can be imported by selecting Library> Convert Legacy (.alb) Library
Files from the program menu. Bear in mind, though, that older content may not be of the same
quality as currently offered catalogs and that legacy Manufacturer catalogs may be out of date.
See “Importing Library Catalogs™ on page 828.

3. Migrate Custom Graphics Files

If you have custom graphics files, including textures, images or backdrops, that you were using
in a previous program version, you can copy them manually using your operating system for
use in Chief Architect X8. See “Chief Architect Data” on page 53.

*  Copy custom texture files to the Chief Architect X8 Textures folder located in the Chief
Architect X8 Data folder.

*  Copy custom image files to your Chief Architect X8 Images folder located in the Chief
Architect X8 Data folder.

e Copy custom backdrop files to your Chief Architect X8 Backdrops folder located in the
Chief Architect X8 Data folder.

In Chief Architect X7 through X1, custom graphics were saved in the Chief Architect Data
folder, as they are in version X8. In version 10 and prior, they were located in the program’s
installation directory, in folders that began with “My”. Custom backdrops, for example, were
saved in “My Backdrops”.

Texture and image files are not listed in the Library Browser. These files can be assigned to
material and image objects, however, which are stored in the library so it is important to retain
them. There are several tools available for adding materials and images to the library. For more
information, see “Images” on page 1134 and “Creating Materials” on page 857.

4. Review the New Features List

There are a number of important reasons why you should familiarize yourself with the new and
improved features in Chief Architect X8:

* New and improved features allow you to produce drawings more efficiently, so it is to your
advantage to use them.
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* Some changes to existing functionality may affect your accustomed drawing style and thus
your productivity if you are not aware of them.

+ New features may affect your choice of settings in your template files, as well as your pre-
ferred Preferences settings.

See “New and Improved Features by Chapter” on page 1328.
5. Review Your Preferences Settings

Any changes that you made to the Preferences settings in your previous version do not migrate
into Chief Architect X8. You should review all the settings in the Preferences dialog to make
sure that they are set to suit your drawing needs. For more information, see ‘“Preferences
Dialog” on page 90.

6. Create new custom Template Plan and Layout files

Chief Architect X8 installs a selection of template plan and layout files that have been set up to
take advantage of the program’s updated tools and features. See “Template Files” on page 84.
For best results, it is recommended that you either:

* Use the installed templates when creating new plans and layout files in Chief Architect X8
» Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program
version, it is very important that you take the time to carefully review all the default settings in
the file, making sure that they will continue to suit your needs in X8. First, make copies of your
custom templates in the Chief Architect X8 Templates directory The Templates directory is
located in the Chief Architect X8 Data folder. Next, open each template as you would a regular
plan or layout file, by selecting File> Open, and then save any changes you make by selecting
File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout
template from the same program version, as well. As with a template plan, take the time to go
through the layout template’s defaults and make sure they are suited for use in X8 and that their
line weight scales do not conflict with those in your template plans. See “Line Weights and
Scaling” on page 1224.

7. Set up Custom Toolbar Configurations

It is possible to migrate toolbar configuration files from previous versions to Chief Architect
X8; however, it is not recommended because it is likely that you will be missing new tools
available in version X8.

Instead, we recommend that you set up your custom toolbars the way you would like them in
Chief Architect X8. You may find it most effective to customize your toolbars as you get used
to working in the new program version, rather than beforehand. See “Toolbar Configurations”
on page 131.
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8. Backup Entire Plan

Before migrating a legacy file created in Chief Architect X7 or prior, it is a good idea to open
the plan in the program version in which it was created and use the Backup Entire Plan tool
(Export Entire Plan in version X3 and prior) to export the plan with all associated support files,
including textures, backdrops and images. See “Backup Entire Plan” on page 70.

9. Check chiefarchitect.com for more information

If you have additional questions about the changes in Chief Architect, up to date information is
available in the Support section of our web site. You can also post questions on the ChiefTalk
web forum at chieftalk.chiefarchitect.com.

Files Created in Version X7 and Prior

In addition to the above recommendations, if you wish to open files created in Chief Architect
Version X7 or prior, bear in mind the following before you open legacy files in Chief Architect
X8.

1. Boxed Eaves

In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they extend
into exterior rooms with “Use Soffit Surface for Ceiling” specified when located between the
roof baseline and an interior room. In some legacy plans opened in Version X8, the Length
value for Boxed Eaves may need to be modified in the Roof Plane Specification dialog. See
“Options Panel” on page 485.

2. Uppercase Text

The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and
prior, it was an option for Room Labels and Schedules only. In legacy plans opened in Version
X8, any Schedules present in the drawing will be assigned a Custom Text Style, as will their
associated Schedule Defaults. If any Schedule Default is set to Use Layer for Text Style and no
objects are present on that layer, a new Schedule Text Style will be created and assigned to that
layer. Room Labels are treated similarly: if any are present, they and their defaults will use a
Custom Text Style. If a given Room Label or Schedule has been sent to layout more than once
and was set to use different Text Styles in each layout view, it is possible that its appearance
may be affected in some views. See “Text Styles” on page 1061.

Files Created in Version X6 and Prior

In addition to the above recommendations, if you wish to open files created in Chief Architect
Version X6 or prior, bear in mind the following before you open legacy files in Chief Architect
X8.
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O 1. Built-in Appliances

In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base
cabinets had incorrect sizing data. In legacy plans opened in version X8, these appliances will
not fit into the cabinet correctly and will need to be replaced. Built-in dishwashers are
particularly affected. See “Built-In Sinks and Appliances” on page 680.

O 2. Formatting of Bulleted and Numbered Lists

In Version X7, various improvements were made to the way lines of Rich Text are spaced. In
legacy plans opened in Version X7, Rich Text objects with bulleted and numbered lists may
require adjustments. See “Paragraph Options Dialog” on page 1037.

(O 3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing.
The change in spacing may increase the overall height of text objects using this font in X6 files
opened in Version X8. X5 and prior legacy files will not be affected by this change. See
“Blueprint Fonts” on page 1030.

For Files Created in Version X5 and Prior

In addition to the above recommendations, if you wish to open files created in Chief Architect
Version X5 or prior, bear in mind the following before you open legacy files in Chief Architect
X8.

(J 1. Named Values for Doors and Windows

In Version X6, the Named Values door_style name, door_type name, and window_type name
were shortened to style name and type name. Any object labels or text macros using these
Named Values in legacy plans opened in Version X8 will need to be replaced. See “Working
with Named Values” on page 1305.

For Files Created in Version X4 and Prior

In addition to the above recommendations, if you wish to open files created in Chief Architect
Version X4 or prior, bear in mind the following before you open legacy files in Chief Architect
X8.

O 1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia,
whereas in Version X5, they are measured to the outside of the fascia or shadow boards, if
present. In legacy plans opened in Version X5, this will not affect the appearance of roof planes
in floor plan view because in X4 and prior, roof plane polylines represented the projected
framing area whereas in Version X5 they represent the total projected area. But, the position of
the fascia and subfascia will shift, as will the length of the rafters. See “Eave and Gable
Overhangs” on page 490.
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O 2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward display interior material on
exterior side of door. This was corrected in Version X8. Doors modified to work around the old
behavior could be affected in legacy plans opened in Version X5. See “Changing Door Swings”
on page 369.

3. Door Swing Direction and Louvers

Improvements to door louver direction may affect louvers in all doors with the exception of
bifold doors. See “Changing Door Swings” on page 369.

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that
were not wrapped. In legacy plans opened in Version X8, the extents of wrapped lintels and
sills will be adjusted so that they equal their Extend setting. See “Door Casing” on page 368
and “Window Casing and Sills” on page 405.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork
symbol to insert into cabinets effectively. In Version X8, the offset is set in the Cabinet
Specification dialogs. When legacy plans are opened in Version X5, cabinet foot offsets are set
to 0 and transferred to their containing cabinet, if one exists. Any customized or independently
placed cabinet feet will be affected. See “Pilasters, Feet, and Moldings” on page 691.

6. Object Labels in Cross Section/Elevation Views

If a “Label” layer is turned on in a cross section/elevation view and objects of that type are
visible in the view, then those objects’ labels will display in that view when the plan is opened
in Version X8. See “Object Labels” on page 1279.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were
visible in rendered views even when their Index of Refraction was set to 1.0. When legacy
plans are opened in Version X8, Transparent materials with an Index of Refraction of 1.0 are
transferred to the General Material class and assigned a Transparency value of 100%. This will
not affect these materials’ appearance in ray trace views, but will make them completely
invisible in rendered views. See “Properties Panel” on page 871.

8. Invisible Beams

The legacy Invisible Beam checkbox was removed from the Wall Specification dialog. When
legacy plans are opened in Version X8, any Invisible Beam walls will be converted to Invisible
Walls. See “General Panel” on page 309.
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For Files Created in Version X3 and Prior

In addition to the above recommendations, if you wish to open files created in Chief Architect
Version X3 or prior, bear in mind the following before you open legacy files in Chief Architect
X8.

O 1. Text Styles

The appearance of a number of objects that include text - including object labels, the North
Pointer, Sun Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now
be controlled using Text Style. Their appearance may be altered somewhat in legacy plans
opened in Chief Architect X8. See “Text Styles” on page 1061.

(O 2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect
X8. Lighting in legacy plans may appear noticeably brighter when viewed in version X8. See
“Light Data Panel” on page 647.

For Files Created in Version X2 and Prior

If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the
following file management changes and structural enhancements before you open legacy files
in Chief Architect X8.

(O 1. Material textures, images, and backdrops

Chief Architect X2 and prior installed with a catalog of library content, including a selection of
material textures, images, and backdrops. This library catalog is no longer installed with the
program because it is now available for download on-demand, so it will be possible to open a
legacy plan in version X8 and encounter numerous missing file warnings. To avoid this, we
recommend using the Export Entire Plan feature in the original program version to create a
folder that includes the plan and all associated textures, images, and backdrops before opening
this file in X8. This tool is renamed Backup Entire Plan in version X8. See “Backup Entire
Plan” on page 70.

O 2. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and
objects such as railings, stairs, landings, cabinets, fixtures, and furnishings measured their
Floor to Bottom height from the subfloor. These objects now measure their Floor to Bottom
height from the floor finish surface by default, so it is possible that you may notice height
changes for these objects - particularly in saved, annotated cross section/elevation views. See
“Floor and Ceiling Platform Definitions” on page 344.
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O 3. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated
from 9 (225 mm) in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X8. This may
affect the riser heights of stairs, as well as the thicknesses of landings attached to those stairs.
See “Staircase Specification Dialog” on page 559.

4. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust
Height checkbox. If a cabinet, fireplace, fixture, furniture, or other library symbol had Follow
Terrain unchecked in version X2 or prior and was located in a room with a floor height other
than the default for the current floor, then the object’s Floor to Bottom Height will change to
equal that room’s floor height. The object’s position in the model will not change, however. See
“Terrain Height vs Floor Height” on page 717 of the Reference Manual.

5. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a
legacy plan file is opened in version X8 and these wall types are detected, they are replaced by
an updated, non-generic wall type. Framed walls and Railings will also acquire 1/2” (13 mm)
thick layers of sheetrock on each side. Railings that define a Deck room with Advanced Deck
Framing Built will not acquire sheetrock layers. See “Legacy Wall Types” on page 304.

6. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will
acquire layers of sheetrock when the plan is opened in version X8. This can affect the
appearance of staircases where they join to a floor platform. To address this issue, select the
railing and move it 1/2” (13 mm) away from the top edge of the staircase. See “Creating a
Stairwell Manually” on page 557.

7. Deck rooms

In legacy plans opened in Chief Architect X8, Deck rooms with Advanced Deck Framing built
retain the framing but have Automatic Deck Framing turned off by default. Decks with no
Advanced Deck Framing built are converted to Balcony rooms. See “Decks” on page 340.

8. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have been
modified. The Ambient setting was removed, and the Diffuse setting for materials in legacy
plans will be set to 100% when opened in version X8.

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified.
Lights using Soft Shadows in legacy plans will be set to use Medium quality. The Light
Diameter of light sources in legacy plans is capped at 4” (100 mm). See “Texture Panel” on
page 869 and “Light Data Panel” on page 647.
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O 9. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X8, Materials
Lists are set to calculate Total Lineal Length. For a combination of lineal length and piece
count, select Mixed Reporting in the Structural Member Reporting dialog. See “Structural

Member Reporting” on page 1286.
O 10. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief
Architect X8 it applies to the entire plan. As a result, it is turned off by default in legacy plans
opened in version X8. See “CAD Defaults Dialog” on page 1072.

New and Improved Features by Chapter

The following is a list of new and improved
features in Chief Architect Version X8.
Where possible, cross-references to
additional information has been provided.

Program Overview

* Added support for 3D Connexion's 3D
mice. See “3D Mice” on page 34.

* Enhanced support for basic math in dia-
logs and when moving objects using
dimensions. See “Math Operations in
Dialogs” on page 40.

* The Move edit handle of a selected fram-
ing object, Soffit, or group-selection will
now shift position to remain on-screen
when you zoom in. See “Edit Handles”
on page 34.

¢ Improved how names with numbers at
the end are sorted in the Project Browser.
See “Project Browser” on page 1125.

File Management

* The Backup Entire Plan =3 tool now
automatically creates a zipped folder. See
“Backup Entire Plan” on page 70.
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New Missing Files dialog assists in han-
dling of missing referenced graphics
files. See “Referenced Files” on page 68.

Preferences and
Default Settings

New Enable ‘Show Room Labels’
Automatic Behavior When Changing
Room Types setting in the Preferences
dialog gives the option of leaving Show
Room Labels unchecked when a Room
Type is assigned to a room. See “Archi-
tectural Panel” on page 108.

New Reset Toolbars button in the
Preferences dialog. See “Reset Options
Panel” on page 126.

New Measure Windows from Inside of
Frame setting for drawings imported
from the Room Planner mobile app in the
Preferences dialog. See “General Panel”
on page 98.

Obsolete Record undo state only if idle
longer than setting was removed from
the Preferences dialog. See “General
Panel” on page 98.



Layers

Layer sets can now be renamed. See
“Layer Set Management” on page 147.

Editing Objects

New Object ok , Room ) , Floor ‘E,

and Plan Pl Modes for the Object
Painter tool. See “Matching Properties”
on page 249.

New properties including Fill Style can
be applied using the Object

Eyedropper @ and Apply Properties

5% tools. See “Matching Properties” on
page 249.

New Elevation Reference setting for a
variety of architectural objects lets you
specify where their height is measured
from. See “Specification Dialogs” on
page 41.

The heights of various architectural
objects can now be measured from either
their top or bottom surface. See “Specifi-
cation Dialogs” on page 41.

The Edit Object Parts toggle has been
replaced by a Connect CAD Segments
H toggle, Disconnect Edges H tool,

and Disconnect Selected Edge [o] edit
tool. See “Connect CAD Segments” on
page 182 and “Disconnect Edges” on
page 184.

Sticky Mode X is now available for the
Break Line = edit tool. See “Break
Line” on page 231.

New Complete Break = edit tool
replaces double-clicking the Break

New and Improved Features by Chapter

Line = edit button. See “Break Line”
on page 231.

New Corner Edit Handles ] and Edge
Edit Handles I toggles for the Break

Line = edit tool. See “Break Line” on
page 231.

Walls, Railings, and Fencing

The Wall Specification dialog now has a
LABEL panel. See “Wall Specification
Dialog” on page 308.

Railing newels, balusters, and rails can
now be displayed in floor plan view. See
“In Floor Plan View” on page 281.

Wall Hatching '€ now only covers wall
layers that are set to display, improving
its usability with railings. See “Hatch
Wall” on page 275.

Rooms

Living Area labels are no longer created

for structures that are not included in the
Living Area Calculation such as detached
garages and decks. See “Living Area” on
page 339.

New Make Room Area Polyline P4 edit
tool creates a polyline showing the
extents of its Standard Area. See “Room
Area” on page 339.

Deck Planking and Joists can now be
specified as Treated. See “Deck Panel”
on page 356.

Improved how deck joists are generated
when Border Planks have been specified.
See “Deck Framing and Planking” on
page 341.
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Improved how deck joists and planking
are automatically generated when deck
joists have been rotated. See “Deck
Framing and Planking” on page 341.

Improved ability of planking in separate
deck rooms to miter along an angled
Room Divider. See “Deck Framing and
Planking” on page 341.

Improved how deck planking is automati-
cally generated for adjacent decks. See
“Deck Framing and Planking” on page
341.

The Display in Uppercase checkbox for
room labels was moved to the TEXT
STYLE panel of the Room Label
Specification dialog. See “Text Style
Panel” on page 1063.

Doors and Windows

Doors and windows can now span the
intersections of straight, collinear walls.
See “The Door Tools” on page 362 and
“The Window Tools” on page 392.

Corner windows can now be pushed fur-
ther into a wall corner to produce a mini-
mal corner post. See “Corner Windows”

on page 395.

Fixed glass corner windows can now
have no corner post. See “Frame Panel”
on page 415.

Architectural objects like cabinets will
now bump against door and window cas-
ings and sills. See “Bumping/Pushing”
on page 221.

When a wall type is specified for a Bay,
Box, or Bow Window placed in a Pony
Wall, it now replaces both wall types and
spans the entire unit. See “General Panel”
on page 430.

Foundations

Slabs = now have a LABEL panel in
their specification dialog. See “Slab
Specification Dialog” on page 463.

Slabs =) now have a Footing Offset set-
ting in their specification dialog. See
“General Panel” on page 464.

Post footings can now be specified as
Round or Square. See “General Panel”
on page 464.

Roofs

New Roof Defaults dialog is accessible
via the Default Settings dialog. See
“Roof Defaults Dialog” on page 475.

Roof framing can now be generated at the
same time as roof planes in the Build
Roof dialog. See “Structure Panel” on
page 487.

The Surface, Structure, and Ceiling lay-
ers of roof planes can now be specified.
See “Structure Panel” on page 487.

The Surface, Structure, and Ceiling lay-
ers of roof planes can now be Auto

Detailed @‘ See “In Cross Section
Views” on page 491.

The Framing Member Type can now be
specified for the rafters of individual roof
and ceiling planes. See “Structure Panel”
on page 487.

New option for a Rebuild Fascia and
Roof Trim hotkey. See “Roof Panel” on
page 481.

Stairs, Ramps, and Landings

Stairs and Ramps now have object pre-
view panes in their specification dialogs.



See “Staircase Specification Dialog” on
page 559 and “Ramp Specification Dia-
log” on page 570.

New Top Height Reference settings con-
trol where a staircase’s Top Height mea-
sures to. See “General Panel” on page
559.

New Break Line settings allow you to
create a break or cut line with optional
transparency on staircases. See “Stair
Break Lines” on page 539.

New settings for creating stair railing
returns and extensions. See “Handrail
Panel” on page 572.

Stair and ramp newels, balusters, and
rails can now be displayed in floor plan
view. See “In Floor Plan View” on page
539.

New “Stair & Ramp, Details” layer con-
trols the display of stair and ramp over-
hangs and tread nosing in floor plan view.
See “In Floor Plan View” on page 539.

New “Stair & Ramp, Stringers” layer
controls the display of stair stringers in
floor plan view. See “In Floor Plan View”
on page 539.

New Handrail at Wall settings allow
railing returns and extensions. See
“Handrail Panel” on page 569.

The Stringer Top and Bottom values in
the Staircase Specification dialog are
now measured from the top front and bot-
tom back corners of stair treads, respec-
tively. Both can now be set to zero, as
well. See “Style Panel” on page 563.

Improved how stairs snap to nearby
walls. See “Drawing Stairs and Ramps”
on page 537.

New and Improved Features by Chapter

Framing

Improved wall framing around floor/ceil-
ing beams. See “Framing with Beams”
on page 582.

New Rotate options in the Framing
Specification dialog allow you to rotate
and align wall framing and blocking
within the wall framing layer. See “Gen-
eral Panel” on page 611.

Wall Blocking fH now displays as a box
with a single diagonal line when cut by a
cross section plane. See “In Cross Sec-
tion/Elevation Views” on page 605.

Improved information text in Wall

Detail [ views. See  In Wall Detail
Views.

When multiple sill plates are specified,
only the bottom one is now Treated. See
“Sill Plates” on page 579.

Trusses

The text of truss labels can now be speci-
fied. See “Truss Labels” on page 621.

Unnecessary Measurements informa-
tion removed from the Truss Base
Specification dialog. See “General
Panel” on page 626.

Automatic Truss label numbering now
begins with 1 instead of 0. See “Truss
Labels” on page 621.

Cabinets

Enhanced control of face items on cabi-
net sides and back. See “Front/Sides/
Back Panel” on page 701 and “Accesso-
ries Panel” on page 706.
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New “Door - Hinge Bottom” and “Door -
Hinge Top” face items create awning and
hopper doors. See “Front/Sides/Back
Panel” on page 701.

New “Side Panel - Applied” and “Side
Panel - Inset” face items. See “Front/
Sides/Back Panel” on page 701.

New Full Overlay and Extend to Bot-
tom options for side panels. See “Acces-
sories Panel” on page 706.

New Floor to Top setting in the Cabinet
Specification dialog. See “General
Panel” on page 697.

Box construction, overlay, and corner
treatment settings are now grouped on the
new BOX CONSTRUCTION panel in the
Cabinet Specification dialogs. See “Box
Construction Panel” on page 700.

New Lock from Auto Resize option for
cabinet face items. See “Front/Sides/
Back Panel” on page 701.

The list of cabinet face items is now
alphabetized. See “Front/Sides/Back
Panel” on page 701.

Cabinet front settings can now be modi-
fied when multiple cabinets are selected.
See “Front/Sides/Back Panel” on page
701.

New Always Present option places cabi-
net feet under cabinets that are not end
cabinets. See “Accessories Panel” on
page 706.

New Retain Toe Kick option preserves
the toe kick on cabinets with cabinet feet.
See “Accessories Panel” on page 706.

Improved functionality of Stretch to Fit
option for toe kicks. See “Accessories
Panel” on page 706.

Cabinet feet no longer display on Corner
cabinets. See “Accessories Panel” on
page 706.

The Custom Countertop and Custom
Backsplash Specification dialogs now
have a LABEL panel. See “Custom Coun-
tertop Specification Dialog” on page 712
and “Material Region Specification Dia-
log” on page 801.

Plants and Sprinklers

New “Unknown” option for plant Hardi-
ness Zones. See “Plant Chooser Dialog”
on page 767.

New Object Type filter in the Plant
Chooser dialog. See “Plant Chooser Dia-
log” on page 767.

The Library

Improved Library Search sorts the most
relevant results first. See “Searching the
Library” on page 824.

The Export Library command is now
available for the User Catalog. See
“Exporting Library Catalogs” on page
835.

All specification settings are now saved
when a symbol object is added to the

library. See “Add to Library” on page
829.

Materials
Improved ability to paint a single wall in

a room using the Material Painter B
See “Material Painter and Walls” on page
851.



Improved interface of the MATERIALS
panel. See “Materials Panel” on page
852.

3D Views

The Cross Section Slider [} now sup-
ports multiple cutting planes. See “Cross
Section Slider” on page 919.

Enhanced panning and zooming in Per-
spective 3D views. See “Repositioning
Cameras” on page 910.

New 3D Focus on Object ¥ tool. See
“Move Camera with Mouse” on page
912.

Zoom Using Field of View setting
replaced by the Perspective Crop Mode

toggle 1. See “To use Perspective Crop
Mode” on page 911.

The active Sun Angle 3%, Toggle

Shadows | B, and Toggle Sunlight 2
status are saved on a per-camera basis.
See “Saving and Printing 3D Views” on
page 922.

Rendering and Ray Tracing

New Adjust Sunlight ~. tool opens the
Adjust Sunlight dialog. See “Adjust
Sunlight Dialog” on page 950.

Sun Angles % and the Generic Sun are
no longer listed in the Adjust Lights dia-
log. See “Adjust Lights Dialog” on page
940.

The Generic Sun now has a defaults dia-
log. See “Generic Sunlight” on page 938.

New and Improved Features by Chapter

The Generic Sun can now be set to follow
the camera. See “Generic Sunlight” on
page 938.

The active Sun Angle »2 can now be
specified on a per-camera basis. See
“Adjust Sunlight Dialog” on page 950.

Sun Angles > now derive their date
format from your operating system set-
tings. See “Sun Angles” on page 944.

The Opaque Window Glass option was
moved from the 3D View Defaults dialog
and made available for most Rendering
Techniques. See “Rendering Technique
Options” on page 954.

New Toggle Shadows B tool. See
“Shadows” on page 934.

Show Shadows moved from the
Preferences dialog to the Camera
Defaults dialog. See “General Panel” on
page 890.

Shadows are now supported in the Vector
View Rendering Technique. See “Vector
View” on page 952.

Now Shadow Intensity option for the
Vector View and Technical Illustration
Rendering Techniques. See “Rendering
Technique Options” on page 954.

Show Shadows can now be specified per
camera view. See “Camera Panel” on
page 924.

Improved handling of reflective surfaces
in Ray Trace views. See “Ray Trace
Views” on page 965.

New Interior and Exterior Ray Trace
Configurations available in the installed
template plans. See “Ray Trace Configu-
rations” on page 967.
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Dimensions

New Auto Story Pole Dimensions b3
tool. See “Auto Story Pole Dimensions”
on page 1011.

New Blank Segment setting added to the
SEGMENTS panel of the Dimension Line
Specification dialog (formerly the ADDI-
TIONAL TEXT panel). See “Segments
Panel” on page 1025.

New Location settings for automatic ele-
vation dimensions. See “General Panel”
on page 1000.

New Elevation Marker settings for ver-
tically oriented dimension lines in cross
section/elevation views. See “Extensions/
Markers Panel” on page 1023.

Text, Callouts, and Markers

New Ellipse, Capsule, Diamond, and
Rectangle callout shapes for Callouts.
See “Callout Panel” on page 1056.

Callouts and Markers now have an object
preview in their specification dialogs.
See “Callout Specification Dialog” on
page 1055 and “Marker Specification
Dialog” on page 1059.

New options for specifying the Align-

ment of Level Line Marker ‘& text. See
“Marker Panel” on page 1060.

New Uppercase option for Text Styles as
well as Rich Text. See “Rich Text Speci-
fication Dialog” on page 1034 and “Text
Style Panel” on page 1063.

CAD Objects

New Blocking Box [ tool draws a
CAD box with a single diagonal line

through it. See “Blocking Box” on page
1102.

Importing and Exporting

Import of .skp files created in SketchUp
version 2016 is now supported. See “3D
Data Import Requirements” on page
1183.

Import and export of .dxf//dwg files cre-

ated in AutoCAD® version 2016 is now
supported. See “Importing 2D Drawings”
on page 1170.

Custom Symbols

New Show Origin X option for custom
symbols in the Symbol Specification
dialog. See “3D Panel” on page 1196.

New Use Imported UV Map option in
the Symbol Specification dialog. See
“3D Panel” on page 1196.

The Height off Floor setting was moved
from the Symbol Specification dialog to
the regular specification dialog. See
“General Panel” on page 844.

Obsolete Components button removed
from the Symbol Specification dialog.
See “Options Panel” on page 1200.

Printing and Plotting

Super B (13”7 x 19”) and E1 (30” x 427)
sheet sizes added to plan and layout tem-
plate files. See “Drawing Sheet Setup
Dialog” on page 1216.

Layout

New Live View options for camera
views, overviews, and cross section/ele-



vation views sent to layout. See “Keeping
Layout Views Current” on page 1243.

New Color Fill option for Vector Views
sent to layout using Plot Lines. See “Send
To Layout Dialog” on page 1241.

Schedules and Object
Labels

New schedule columns allow you to
insert dynamic object previews into most
types of schedules. See “General Panel”
on page 1274.

New Framing Schedule tool can be
used to create framing, deck framing, and
truss schedules. See “Schedules and
Object Labels” on page 1267.

New Ellipse, Capsule, Diamond, and
Rectangle callout shapes for schedule
labels. See “Label Panel” on page 1277.

Object labels and schedules now support
multiple lines of text. See “Label Panel”
on page 1280 and “Using the Edit Han-
dles” on page 1269.

CAD objects as well as CAD-based
architectural objects like slabs now have
labels. See “Label Panel” on page 1280.

New and Improved Features by Chapter

The Display All Text in Uppercase set-
ting for schedules replaced by Uppercase
style option for Text Styles. See “General
Panel” on page 1274.

Materials Lists

New Include Hidden Columns option
when exporting a Materials List. See
“Materials List Export Dialog” on page
1296.

The Structural Member Reporting dia-
log can now be accessed via the Tools
menu. See “Structural Member Report-
ing” on page 1286.

New Structural Member Reporting
Method drop-down in the toolbar lets
you change the reporting method used by
an active Materials List. See “Structural
Member Reporting” on page 1286.

Ruby Console

New named values for layers, stairs, cabi-
nets, and trusses. See “Working with
Named Values” on page 1305.
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